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QA/QC Functionality in MARS® version 2017.x 

 

1. Check Point Report 

a. Inputs section 

b. Statistics and Standards sections 

c. Other Functions 

2. LAS Statistics 

a. Created During Tile Scheme Generation 

b. Run on Single or Multiple Classes 

c. Run During Collection Scan Polygon Generator to Report Statistics per Collection Scan 

d. Run on an Existing Tile Scheme 

3. ‘LiDAR Spatial Distribution Verification GRID’ Tool 

4. Cross-Section/Profile 

5. ‘Rotate Profile’ Tool and Hot Key 

6. Color bys 

a. Elevation Color Repeat 

b. Intensity Color Extremes 

c. Blend with Intensity 

d. Collection Scan 

 

7. ‘Lock to View 100%’ Tool 

8. Contours 

a. In Export 

b. With Breaklines 

c. Color 

d. 100% View 

e. ‘Contour Join’ Tool 

9. ‘Swipe’ Raster Over LiDAR Tool 

10. ‘Coverage Tracking’ Tools 

11. Contour by Collection Scan 

12. Check for Crossing Breaklines 

13. Scale Bars 

14. ‘Collection Scan Direction’ Option 

15. Z Delta/Flight Line Separation – JPEG 2000 

16. Hillshade 

a. Color by 

b. Export to JPEG 2000 
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17. Ability to Add and View a Float Grid in 2D or 3D 

18. ‘Flood Fill’ Tool 

19. Real-time LAS Shifting 

a. LAS Shifting (X, Y, and/or Z) 

b. Z Shift on Intensity 

c. Z Shift on Class 

d. Z Shift For LAS Files 

20. ‘Collection Scan Polygon Generator’ Tool 

21. Batch Script Test Function to Step (Forward and Back) Through Macros 

22. ‘Convert SBET to Shapefile’ Tool Coupled with ‘Scan Angle’ Filter 

23. ‘Single Collection Scan to Multiple’ Tool  
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1. Check Point Report: 

For LiDAR data that has been corrected for systematic errors, the project’s ground check points can be validated against 

the derived LiDAR ground surface via the Check Point Report utility within MARS®. This tool verifies the accuracy 

requirements for the LiDAR data and serves as the critical tie between project control and coordinate systems. MARS® 

allows the user to specify the desired vertical accuracy for the statistical analysis of the check points and can also 

generate a hard-copy check point report. Simply put, this tool compares the accuracy of the remotely collected data with 

the known points on the ground, which can help uncover data integrity issues within the dataset. In order to generate a 

check point report, check point data must be loaded along with the corresponding LiDAR data. Check points must be 

stored in a *.CSV file. To generate a check point report, click the ‘Check Point Report’ button on the ‘QA/QC’ tab. The 

first time the check point report is created, the user is asked which point classifications to include in the report 

calculations, as well as the calculation method and vertical units for the loaded LiDAR points. Once these settings are 

made click the ‘OK’ button and the ‘Check Point Report’ interface will appear (see below). 
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a. Inputs section: 

• ‘Requirement’: This is the target vertical accuracy requirement (in metric units). During the calculation of the check 

point statistics, comparisons are made to these values to see if the desired vertical accuracy is met.  

 

• ‘Elevation Calculation Method’: There are two elevation calculation methods: TIN and Grid (TIN is the default). In 

‘TIN’ mode, a TIN is created around each enabled check point, using LiDAR points in the included class(es) within 5 

units of horizontal distance. The one triangle that covers the check point XY location is then selected. The location on 

the surface of this triangle that matches the XY location of the check point provides the elevation value of the surface. 

This elevation value is a linear interpolation of the elevations of the three TIN vertices. Simply put, it is the point in 3-D 
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space on the TIN triangle at the check point’s XY location. The second method, 'Grid', allows the use of a virtual grid 

for check point report statistics to be generated on rather than the actual TINned LiDAR data. The purpose of 

calculating a check point report on virtually gridded data is to report the accuracy of generated elevation grid products 

(DEMs) and any contours produced from them. Options when using the 'Grid' method include the 'Grid Cell Size' and 

the 'Gaussian Smoothing Count'. A large grid size interpolates more varying elevation as a single grid cell elevation 

value. The smoothing count value tells the software how many times to smooth the data - more smoothing results in 

less accuracy. 

 

• ‘Classifications Included’: This list box shows which data classifications are to be used to calculate elevation for 

either method. By default, classes 2 (Ground) and 8 (Model Key-points) are selected. 

 
 

b. Statistics and Standards sections: 

 

• RMSEz Requirement: This is the target root mean squared error (RMSEz) value for the project, which defines the 

vertical (Z) accuracy requirement. The user may specify either the RMSEz value or the vertical accuracy requirement. 

During the calculation of the check point statistics, comparisons are made to the RMSEz value to see if it meets the 

desired accuracy requirements. To achieve the target accuracy requirements, the calculated RMSEz value is 

compared to the target value to determine if the check points are within an acceptable margin of error to be labeled 

‘PASS’. 

 

‘Statistics for NVA Points of Project’: 

• Check Points: This is the total number of check points in the project. 

• Points with Coverage: This is the number of check points with an elevation value that can be computed from nearby 

LiDAR data. More specifically, when computing the Z elevation from a TIN, this is the number of check points where a 

covering triangle is found. 

• NVA Points: 

• VVA Points: 

• Average Vertical Error: For all check points with coverage, this is the average value of the ‘Z Error’. 

• Maximum Vertical Error: For all check points with coverage, this is the highest positive ‘Z Error’ value. 

• Median Vertical Error: For all check points with coverage, this is the median of the ‘Z Error’ values. 

• Minimum Vertical Error: For all check points with coverage, this is the lowest negative ‘Z Error’ value. 

• Standard Deviation of Vertical Error: This is the standard deviation of the ‘Z Error’ for the check points. 

• Skewness of Vertical Error: 

• Kurtosis of Vertical Error: 

• RMSE of Z for Sample: This is the RMSE of the Z value from the data as compared to the check points. 

• FGDC/NSSDA Vertical Accuracy: This value, derived from the RMSE of Z for the check points, is the vertical 

accuracy as defined in Geospatial Positioning Accuracy Standard, Part 3, National Standard for Spatial Data 

Accuracy, FGDC-STD-007.3-1998. It is the RMSE value multiplied by a factor based on the confidence level. For the 

95% confidence level, the multiplication factor is 1.96. 
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If this value is less than the ‘Vertical Accuracy Requirement’ value, then the result is labeled as ‘PASS’ on the 

Check Point Report dialog (to the right of the ‘FGDC/NSSDA Vertical Accuracy’ value). 

 
c. Other Functions: 

Shows the Z error calculated in the report thematically. Red represents negative error (surface lower than check point) 

and green represents positive error. The relative size of the error is represented by the size of the square shown. The 

larger the square, the larger the Z error. 

 
 

 

 

2. LAS Statistics 

a. Created During Tile Scheme Generation: 

In order to produce LAS Statistics during the creation of a unique tile scheme, the user must first access the ‘Create Tile 

Scheme’ interface. This can be done by clicking the ‘Create Tile Scheme’ button on the ‘Vector Creation’ tab. After 

defining all the specifications to create a tile scheme, make sure that the ‘Calculate LAS Statistics, and save to Attribute 

Table’ option is chosen. 

 

 

✓ ‘Calculate LAS Statistics, and save to Attribute Table’: This tool allows the user to create statistics for each 

tile. By choosing this option, the user will make the 'Class Statistics' option available. The user may then select the 

classes on which statistics will be created. Checking this option will populate the following statistics and make them 

available to the user through the attribute table of the tile shapefile as shown below: 
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ID:  A uniquely-generated ID number for each tile created. 

TName: The TName is a uniquely-generated tile name with a starting number specified by the user. 

AREA: The area in project units of a particular tile. 

ALLPCOUNT: A count of the total number of points within a particular tile. 

DENSITY: The point density in points per square unit (using first returns only). 

AVG_GSD: The average GSD (ground sample distance). 

X_MIN: The x axis (easting) minimum within a particular tile. 

X_MAX: The x axis (easting) maximum within a particular tile. 

Y_MIN: The y axis (northing) minimum within a particular tile. 

Y_MAX: The y axis (northing) maximum within a particular tile. 

Z_MIN: The z axis (elevation) minimum within a particular tile. 

Z_MAX: The z axis (elevation) maximum within a particular tile. 

Z_DELTA: The difference between Z_MAX and Z_MIN within a particular tile. 

COLL_SCAN: A listing of the different collection scan numbers which overlay a particular tile. 

GPS_MIN: The GPS time (timestamp) minimum found within a particular tile. 

GPS_MAX: The GPS time (timestamp) maximum found within a particular tile. 

MIN_INT, MAX_INT, MEAN_INT, MED_INT, and MODE_INT: Various intensity value statistics. 

RETURN_0: The number of ‘other’ returns found within a particular tile (returns that are missing or have incorrect 

point family info).  

RETURN_1 through RETURN_15: The number of first returns through fifteenth returns (listed in individual attribute 

fields) found within a particular tile. 

SYNTHETIC: The number of points bit-flagged as ‘Synthetic’ found within a particular tile. 

MKP: The number of points bit-flagged as ‘Model Keypoint’ found within a particular tile. 

WITHHELD: The number of points bit-flagged as ‘Withheld’ found within a particular tile. 

OVERLAP: The number of points bit-flagged as ‘Overlap’ found within a particular tile. 

Class0 through Class 255: The number of points in each class (listed in individual attribute fields) is recorded per 

tile. 

iShape: A MARS®-specific value that is not relevant for the user. 

 

 

It is also possible to view statistics about the attribute values in the tile shapefile. The user may view the statistics of a 

single attribute (column) for one or more tiles (rows), or the entire table. Highlight the tiles for which statistics are to be 

viewed, right-click on the desired column header, and choose 'Statistics'. The resultant pop-up table will show the user 

the following statistics: row (tile) count, minimum, maximum, sum, mean (average), and median of the chosen attribute. 

To select multiple rows for viewing at once, use the 'Shift' or 'Ctrl' keys on the keyboard. In the example below, the user 

is choosing to view the ‘ALLPCOUNT’ statistics of all tiles. 
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b. Run on Single or Multiple Classes: 

To create LAS statistics on single or multiple classes the user must choose the desired class(es) for which to populate 

statistics in the ‘Statistic Classes’ GUI. This interface will appear when the user clicks the ‘Select’ button to the right of 

the ‘Class Statistics’ box on the ‘Create Tile Scheme’ interface (see above). Simply choose the class or classes for 

which LAS Statistics are to be populated. 
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c. Run During Collection Scan Polygon Generator to Report Statistics per Collection Scan: 

Statistics can also be run to calculate first-return density and GSD per collection scan in the ‘Collection Scan Polygon 

Generator’ tool. This tool can be found on the ‘Vector Creation’ tab and allows the user to choose which classes to run 

statistics on and whether to use a Grid or virtual TIN to determine the boundary of each collection scan. The statistics 

stored in the resulting shapefile are identical to those listed in Section a. (above), except that ‘TNAME’ is replaced by 

‘FILENAME’ to indicate the collection scans processed. 

d. Run on an Existing Tile Scheme: 

In order to produce LAS Statistics on an already existing tile scheme, click the ‘Populate Statistics on Tile Scheme’ 

button on the ‘Analysis’ tab. The shapefile for which the user would like to populate statistics must first be loaded as the 

tile shapefile within MARS®. Using this tool will create a new tile shapefile in the same folder where the loaded tile 

shapefile exists; it will contain populated fields for the attributes listed in Section a. (above). Additionally, 256 columns will 

be added to the end of the table that list the Model Keypoint bit flag count per class (ClassMK0 through Class MK255). 

The file will be named ‘<input tile shapefile name>_With_LAS_Statistics.shp’ 

 

3. LiDAR Spatial Distribution Verification GRID Tool: 

This tool is used to create a grid that contains values representing the presence (value = 1) or void (value = 0) of a first (of 

any) return LiDAR point within any portion of a predefined grid cell size. This tool creates a JPEG 2000 as the final 

product. The development criteria for this tool were based upon the USGS LiDAR Base Specification Version 1.0 

(Techniques and Methods 11-B4), as currently stated: 

'The spatial distribution of geometrically usable points is expected to be uniform. Although it is understood that 

lidar instruments do not produce regularly gridded points, collections should be planned and executed to produce 

a first-return point cloud that approaches a regular lattice of points, rather than a collection of widely spaced high 

density profiles of the terrain. The uniformity of the point density throughout the dataset is important and will be 

assessed using the following steps: 

• Generating a density grid from the data with cell sizes equal to the design NPS times 2, using a radius equal to the 

design NPS. 

• Ensuring at least 90 percent of the cells in the grid contain at least one lidar point. 

• The assessment is to be made against individual (single) swaths, using only the first-return points located within the 

geometrically usable center portion (typically 90 percent) of each swath.  

• Excluding acceptable data voids previously identified in this specification. 

Note: This requirement may be relaxed in areas of substantial relief where it is impractical to maintain a consistent 

and uniform distribution. 

Note: The process described in this section relates only to the uniformity of the point cloud distribution. It in no 

way relates to, nor can it be used for the assessment of point density or NPS.' 

 

To use the 'LiDAR Spatial Distribution Verification Grid' tool: 

1) Start by loading the LAS data for the particular project in question. 
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2) When the data has been loaded, select the 'Export'  button or the 'Export Area'  button. Please see a 

screen shot of the export interface that pops up below. 

 

 

3) When the export interface appears, specify an output directory. The output directory will be the folder in which the 

final JPEG 2000 (*.jp2) and resulting *.txt file can be found after processing is complete.  

4) Choose the 'LiDAR Spatial Distribution Verification GRID - JPEG 2000' option in the 'Type' drop down box. 

5)  At this time, the 'Save to Local Option' will appear. It is strongly suggested that the user select this option to use 

temporary disk space to speed up processing. The 'Temporary Folder' specified WILL NOT be the output folder 

(final destination of the JPEG 2000 produced). This folder is simply a directory which has free space that can be 

used to speed up the processing of the export. There must be a folder specified in the 'Temporary Folder' text box 

to use this option. 

6) Under the 'Layout' tab in the Export interface, specify a file name for the newly created .JP2 file in the 'File' text 

box. Because the USGS specifications are for use with an entire project and not tiled data, this tool is intended for 

use with the 'Single File' (when using the 'Export' button) or 'User-defined Box' (when using the 'Export Area' 

button) layout types. 

7) Under the 'Grid' tab in the Export interface, make sure that the 'LiDAR Spatial Distribution Verification' option is 

checked on.  

8) At this time, the 'Number of points required in cell' text box is available. The user may define the number of 

points required within each cell with this text box. The default number of points in a cell will remain at ‘1’, unless the 

user specifies differently, to meet USGS specifications. The 'Exclusion Shapefile' option also will become 

available in the 'Grid' tab. The 'Exclusion Shapefile' option is meant for use with a polygon shapefile. A typical 

polygon shapefile for use with this tool will contain polygons around all water bodies which may cause the resulting 

output grid file to produce a '0' value. A zero (0) value would indicate that no LiDAR point was discovered inside that 

particular cell and that cell would then 'fail' the test as described above. If all the cells found inside a body of water 

record a zero value, it could cause the entire project area to fall below the 90% pass rate of cells containing a value 

of 1 (cells which contain at least one point). Because LiDAR is absorbed by water, water should be excluded from 

the test results. The 'Exclusion Shapefile' option allows the user to place polygons around any water bodies which 
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may result in a '0' value and exclude those polygons from the results. Using this parameter when producing a 

LiDAR Spatial Distribution Verification grid is optional.   

9) When the 'LiDAR Spatial Distribution Verification' option is checked on, the 'Minimum Zero Count to set 

NODATA value' also becomes available. This option may be applied in areas where a large number of '0' value 

cells is anticipated, as in the case of a water body. This option implements a maximum number of contiguous '0' 

cells and changes the value of those '0' cells to a value of 'NULL'. This will automatically delineate large data void 

areas such as water bodies. This option can be used as an alternative to the 'Exclusion Shapefile' option and 

accomplishes the same general purpose. After checking the 'Minimum Zero Count to set NODATA value' option, 

the user may enter an integer in the adjacent text box. As an example, if the user entered '3' into this text box, the 

software would look for 3 contiguous cells containing a '0' value and change all 3 to a 'NULL' value. The purpose of 

this tool is to allow the user to obtain a more accurate pass percentage if no exclusion shapefile should exist.  

10)  Also under the 'Grid' tab on the Export interface is the 'Auto boundary algorithm' option. The 'Slow (More LiDAR 

points used)' option will be checked by default and the 'Fast' option will not be available.  'Slow' uses more LiDAR 

points to more accurately determine the edge of the data. In using this tool it is important that the edge of any water 

body, or any other area which may report a zero value in a cell, be very accurately determined. This will make the 

report containing the number of '0' cells, the number of '1' cells, and the percentage of cells containing a '1' value 

more accurate. Using the 'Fast' option with this tool would skew the results. 

 11)  If any other parameters need to be set, please enter those settings on the appropriate tabs of the export interface.  

12) A multi-threading tool may be found in the MARS® export utility. It is available for use with most export types, and 

it functions to speed up export by using a specified amount of a computer’s CPU processing power. The multi-

threading options can be found at the bottom of the export interface in the right hand corner. Initially, the text box 

will show the maximum number of threads available for processing. Leave as is, or enter the desired number of 

threads to use in processing here. If ‘1’ is entered in the text box, it is equivalent to single-threading the process. 

Ideally, there should be a minimum of three (3) GB of RAM available (not just installed) per thread for best 

performance. 

13) When all the parameters of the export have been set, press the 'Export' button at the bottom of the interface. The 

progress bar, elapsed time, and estimated time to complete will allow the user to see the export in process. 

14) When the export has completed successfully, a prompt will appear.  

 

 

Below is an example result of the LiDAR Spatial Distribution Verification Grid tool. The green areas represent cells with a 

value of ‘1’, meaning they have at least one LiDAR point within the cell. The red areas represent cells with a value of ‘0’, 

meaning they DO NOT contain any LiDAR points. In the example below it is easy to see that there is a body of water 

running through this area, which is the cause of the red cells with a ‘0’ value. If the user were to implement the 'Minimum 
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Zero Count' option when running this tool, the areas of contiguous ‘0’ cells (the water body) would return a ‘NULL’ value 

instead of a ‘0’ value.  

 

 

The 'LiDAR Spatial Distribution Verification Grid' tool will also output a results text file (*.txt) every time the tool is used. 

This file will be output to the same location as the JPEG 2000 (the location specified by the user in the output directory 

browse box). The text file will be named beginning with the date, time, and 

‘…LiDAR_Spatial_Distribution_Verification_Results.txt’.  This allows each *.txt created to be unique. For instance, the file 

seen in the screen shot below was produced on February 2, 2011 at 2:45 pm. 

 

 

 

The text file will contain the following information: the number of cells with a ‘0’ value, the number of cells with a ‘1’ value, 

and the number of value ‘1’ cells as a percentage of the total number of cells. This last value will be the percentage of 

passing cells. This percentage needs to be 90% or above to be in compliance with the USGS specifications mentioned 

above. The screen shot below shows an example of the information contained in the text file. 

 

 

 

4. Cross-Section/Profile: 

The cross-section/profile tools are useful in evaluating data for calibration (collection scan/mission alignment) and 

obtaining measurements from elevation data. Cross-sections and profiles can also be exported.  This tool first allows the 

user to see a ‘cross-section’ through the data. A cross-section has more depth than a profile, which is only a linear cut 

through the data. To create a cross-section (which will appear in a separate ‘MARS Profile View’ window) use the 'Place 

Cross-Section Line'  button or the 'Place Adjustable Cross-Section Line'  button to create a cut through the 

point cloud or TIN.  Even if the data in the LAS Map View window is being rendered as a TIN, the ‘Cross-Section/Profile 

View’ window will render the data as LiDAR points. 
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As mentioned above, there are two methods for cross-sectioning data: 

1.  Place Cross-Section Line: This tool requires the user only to select the length of the cut and defaults to 

the depth set in the 'Options tab  Miscellaneous Options Default cut area depth’. 

 

 

2.  Place Adjustable Cross-Section Line: This tool requires the user to select the length and depth of the cut.  

The button is located immediately to the right of the ‘Place Cross-Section Line’ button. 

 

There are three ways to view the resulting data in the ‘Cross-Section/Profile View’ window: 1. by the Cross-Section 

view, 2. by the Profile by Collection Scan view, or 3. by the Profile Combined view. 

1.  Cross-Section: The Cross Section view will create a cross-section of points in the cross-section/profile 

area. To modify the sizes of the LiDAR points in the cross-section/profile window, click the ‘Show Point 

Size’  button. This action will cause the points closest to the ‘observer’ to be displayed 

relatively larger, while those points on the far side of the cut depth will be displayed relatively smaller.  

2.  Profile by Collection Scan: This view will render the points in a unique color by collection scan. 

3.  Profile Combined:  The Profile Combined view will combine the points from all applicable collection scans 

and display the profile line as an average elevation. 

 

To exaggerate the scaling of the cross-section/profile window display, the user can slide the ‘Vertical Scale’   

slider bar inside the cross-section/profile window or simply type in the scale to be viewed in the text box. Click the ‘1x’ 

 button to return the scale to the original, or ‘true,’ state. This tool is normally used to evaluate the ground control 

points in relation to the classified LiDAR ground points (aka Model Keypoints). Maximum exaggeration is 1000x. 
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5. ‘Rotate Profile’ Tool and Hot Key: 

The ‘Rotate Profile’ tool only functions when the cross-section/profile window is open, and allows the user to rotate the 

cross-sectioned/profile area a specific number of degrees in a clockwise (positive value) or counter-clockwise (negative 

value) direction. To use this tool click the ‘Rotate Profile' button on the ‘Cross-Section/Profile’ tab after a cross-

section/profile has been created for the area in question. 90 degrees is the default rotational value, but any numerical 

value (including negative) may be entered. Select ‘OK’ to see the results in both the LAS Map View window and the cross-

section/profile window.  

 

This tool also has a keyboard accelerator, or hot key, option. To bring up the rotate window (as shown below) without 

using the button, select the letter ‘R’ on the keyboard when the cross-section/profile window is active. If the user attempts 

to use the keyboard accelerator when the cross-section/profile window is NOT open, the window will re-open and the view 

will be rotated by the specified amount, IF the cross-section/profile window has been open previously in the current 

MARS® session. 

 

 

6. Color By Settings Used in QC 

a. Elevation Color Repeat: 

Using the ‘Repeat’ option (under the ‘Coloration Options | Elevation’ button on the ‘View” tab) can help the user see 

fine elevation detail in the LiDAR surface. 

The view by elevation tool colors the LiDAR data by elevation. This tool is linked to the 'Color by Elevation'  button. 

‘Hot’ colors such as red or orange are higher elevations, while ‘cool’ colors such as purple and blue represent lower 

elevations. The ‘Repeat’ option allows the user to adjust the color repeat cycle on different elevations. In the example 

below, the screen shot on the left represents 0 color gradations used between principal colors creating a total of 5 color 

changes. The second example on the right represents 10 color gradations between principal colors creating a total of 55 

color changes.  Much more elevation-difference detail is visible with more gradations. 
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b. Intensity Color Extremes: 

Using the ‘Color Extremes’ option (under the ‘Coloration Options | Intensity’ button on the ‘View’ tab) can help the user 

to highlight the ends of the intensity spectrum. 

The view by intensity tool colors the LiDAR data by intensity. This tool is linked to the 'Color by Intensity'  button. 

The Color Extremes setting allows all extreme intensity values to be displayed in color instead of grayscale. All points that 

have an intensity value equal to 0 are displayed in blue, and those with an intensity value equal to 255 (for 8-bit intensity 

data) are in yellow. 

 

 

c. Blend with Intensity: 

This visual tool  (on the ‘View’ tab) will display LiDAR points by intensity value and allow the user to blend this display 

with other ‘color by’ views. Intensity may be blended with elevation, classification, return, collection scan, ground color, or 

AGC. There is no terrain relief when viewing LiDAR data by intensity alone, but the ability to view intensity along with 

another rendering method may allow the data to be viewed more efficiently. Please see the following examples for further 

explanation.  

 

In the example below, the LiDAR data is being viewed by return only. By viewing only the return values, it is impossible to 

know which characteristics in the terrain the first return (blue) or second return (red) data correspond to.  
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The example below is of the same area, but the ‘Blend with Intensity’ tool has been utilized with the return values in the 

LiDAR data. It is now easy to see that the first return data (blue) corresponds to areas with roads and buildings (solid 

surfaces, typically) whereas the second return data (red) corresponds to areas containing trees. 

 

 

d. Collection Scan: 

This tool  (on the ‘View’ tab) colors LiDAR points based on the collection scan they belong to. Clicking the 'Color by 

Collection Scan' button will render each collection scan’s points by a unique contrasting color as shown in the example 

below. By displaying this way, the user can identify gaps in the collected dataset or easily see boresighting corrections 

that need to be made. In addition, visibility and color of individual collection scans may be set with the ‘Edit Collection 

Scan Display’ button  . 
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 7. ‘Lock to view 100%’ Tool: 

This tool  is intended for hand editing purposes and when drawing Virtual Contours. The density percentage on the 

left side of ‘Status Bar’ tells the user the percentage of LiDAR points which are currently being displayed.  

 

Please see the screen capture below as an example. The screen shot below shows the user viewing point density at 

100%: 

 

Hand editing should only occur when the user is viewing points at 100% density. It is easy for the editor to zoom in/out or 

lose/gain point density frequently throughout the hand editing process by maneuvering around the project, and this tool 

allows the editor to lock the point density of the display at 100%. To use this tool, zoom into the data to 100%. Then click 

on the 'Lock to view 100%' button. If the user attempts to zoom out to full extent by using the ‘Fit to View’ button while 

this tool is activated, the following prompt will appear. 

 

If the user answers ‘No’ to the question above, MARS® will return the user to the LAS Map View window and the 'Lock to 

view 100%' tool will remain activated. If the user chooses ‘Yes’ to the question above, the user will be able to zoom out to 

full extent with the 'Lock to view 100%' tool still activated. If the user should need to deactivate this tool, it can be done by 

clicking on the button on the ‘View’ tab. Another purpose of the prompt as seen above is to prevent a possible crash if  

MARS® attempts to display the full extent of the project area at 100% density. 
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8. Contours: 

a) In Export: 

✓ The user is capable of designating a ‘Max TIN Edge Length’ for contour export. The length specified by the user 

sets the maximum length of TIN triangle edges which are used in the export. This option is applicable to both 

the ‘TIN’ and ‘Grid’ algorithm options on the ‘Contours’ tab in the export interface. When using the 'Grid' 

algorithm, the software will create an ‘internal’ TIN to assist in the creation of the grid.  

  
✓ MARS® is able to clip contours to an irregularly-shaped boundary represented by a polygon shapefile. This 

option is called ‘Clipping Data’ and is found on the ‘Layout’ tab of the export interface. This option allows the 

user to browse to a polygon shapefile (other than the tile shapefile) in the ‘Boundary File’ box. Using this option, 

the contours to be exported will be clipped back to the extent of the specified shapefile. 

 

 

✓ The 'Contours’ tab of the export interface offers the user the ability to specify an edge-tie tolerance. The edge-

tie tolerance setting allows the user to set the distance between ends of two contour lines which will be joined or 

‘tied’ during export. This tool only functions on the tile edge and will not join contour lines in any other area. The 
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default edge-tie tolerance setting is 2 ground units. This tool will look for same-elevation contour line ends which 

are 2 units or less apart at the tile edge and simply connect them, creating one unbroken contour line. In the 

example below, two contours have reached the tile edge and have been cut at the tile edge. This can occur 

whenever a project is processed by tile. Because the ends of the two contours are 2 units or less apart and 

occur at the tile edge, they will be joined.  

 

 

✓ The ‘Clean tolerance’ setting in the ‘Contours’ tab lets the user set the minimum distance between vertices of 

contour lines. This tool only functions on the interior of a tile/export area and will not ‘clean’ line work at 

tile/project edges. The default tolerance setting is 0.01 ground units. This tool will look for contour lines with 

vertices which are 0.01 units or less apart and simplify them, removed unneeded vertices. In the example 

below, the two vertices indicated are less than 0.01 units apart. Rather than keep the sharply jutting area of the 

contour line intact, the software will create a more aesthetically pleasing contour line by deleting this spike. The 

tolerance may be set to any value by the user. 

 

 

• An option called ‘Edge-tie directory of existing shapefile’ is located on the ‘Contours’ tab in the export interface. 

This option allows the user to point to an existing folder containing contour shapefiles. This folder cannot be the same 

as the output folder. The existing contours MUST contain an 'Elv' attribute field with the elevation values populated for 

each contour. This allows the program to 'edge-tie' each contour line being exported to contours in previously-created 

shapefiles. Often, contours lines are cut when data is dissected into tiles. The elevation of contour lines created 

separately in these tiles may not match up when tiles are placed back together to create a single dataset. This option 

inside the contour interface creates a scenario in very few contours will be left 'dangling' or not connecting properly 

with the continuing contour line in another tile. 
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✓ To further save QA/QC time, both the ‘TIN’ and ‘Grid’ export algorithms in MARS® have been refined to prevent 

the software from exporting contours with dangles, self-intersections, and overlaps. 

 

b) With Breaklines: 

✓ Contours will respect all breaklines whether they are loaded into MARS® as reference breaklines or are fully-

functioning breaklines. In the example below the user can see; a) contours created in MARS® over a river with 

NO breaklines enforcing the riverbanks and, b) contours created in MARS® over a river with breaklines loaded. 

Because the breaklines create a level surface between the two shore lines, contours do not cross the river. 

a)                                                                     b) 

       

 

✓ MARS® is capable of displaying contours with only breaklines loaded. It is not necessary to have LAS data 

loaded to view contours. 

 

c) Color: 

To make contour lines more easily visible against certain background colors and therefore more easily QC’ed, the user 

has the option of changing the display color. To use this feature, click on the ‘Virtual Contours | Options’ button on the 

‘Analysis’ tab. Click on the box to the right of the word ‘Color’ to select a new color. The user may choose from the pre-

defined color palette or define a custom color. An example of the ‘Contour Options’ and the ‘Color’ window may be seen 

below. 
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d) 100% View: 

MARS® will only show Virtual Contours when the user is viewing the LiDAR data at 100% point density. 

  

This example shows that the user is currently zoomed in to 33%. 

This density percentage value can be found on the left side of the Status Bar. 

 

Zoom in until the percentage of points displayed equals 100% or enable the ‘Lock to view 100%’ button. The 'Area to 

Display' tool cannot be used unless the user is displaying the data at 100% density. 

 

e) ‘Contour Join’ Tool: 

This tool , found on the ‘Tools’ tab, allows the user to join (dissolve) multiple contour lines into one 

continuous contour line.  Only contours that share endpoints, and are the same in type and elevation, can be joined. 

 

For example, the screen shot below shows a contour line which was split between the two tiles shown during export, and 

remains as two separate lines after merging the contour shapefiles together. These two lines truly represent a single 

contour line. 
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In the figure below, the 'Contour Join' tool has been run on the same contours as shown above. The contour which was 

cut at the edges of the two tiles during export is now re-joined into a single feature.  

It was joined where indicated by the white circle.  

 

 

9. ‘Swipe Raster Over LiDAR’ Tool: 

Yet another QA/QC tool available from MARS® is the 'Swipe Raster Over LiDAR' tool found on the ‘View’ tab. Both a 

raster image and LiDAR data must be loaded to use this tool. When checking the alignment of these two data types, it is 

most advantageous to have the LiDAR data in TIN mode.  

 Swipe Raster Over LiDAR: This tool allows the user to move imagery over LiDAR data for rapid viewing of 

alignment between LiDAR and imagery.  

The MARS® window below shows the swipe tool working between imagery and LiDAR data. 
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10. Coverage Tracking Tools (available with Production license only): 

The Coverage Tracking Tools (on the ‘QA/QC’ tab) are designed to make a polygon shapefile tracking where the user has 

been in the project. This helps to document which areas of a project have been edited or checked. This toolbar works like 

a recorder in that the user is capable of starting a recording, leaving the tool running while performing edits or checks, and 

then stopping the recording. The user is also capable of saving the recorded shapefile for later use. 

To use this tool, simply click on the ‘Start Coverage Tracking’ button. The software will begin to track the movement of 

the editor and the area which was seen on the screen each time the editor panned across the project. When editing or QC 

is complete, click the ‘Stop Coverage Tracking’ button. After recording has been stopped, click the ‘Save Tracking to 

Shapefile’ button if desired. The software will create a polygonal shapefile noting every extent that was viewed by the 

editor while the recording was running. 

 

1)  Start Coverage Tracking: Use this tool when checking, editing, or during any other activity where it is 

useful for the user to track movements across the project. 

2)  Stop Coverage Tracking: Select this button to stop the recording process. At this time, the user’s 

movements across a project will no longer be noted in the shapefile created when the tracking path is saved. 

3)  Save Tracking to Shapefile: When the user has started and stopped a recording tracking the 

movements across a project, the recording can then be saved as a polygon shapefile. This shapefile will show 

the extents that have been viewed. This can be useful in double-checking that a project area has been fully 

examined. 

 

Example: Each blue rectangle represents an area of the MARS® map view window and the data that was viewed inside 

that area. With this coverage tracking tool, it is easy to see that all of the data below has been viewed in this sample data 

and no area was left unchecked. 
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11. Contour by Collection Scan: 

Another QA/QC tool available within MARS® is the ‘Contour by Collection Scan’ option in the Contour Options interface. 

This tool generates individual contour lines based on the collection scans within the area-of-interest, which can help the 

user determine the overall accuracy of the collection scans in relation to each other. This type of contour generation is an 

option within the ‘Contour Options’ dialog, which can be launched by clicking the ‘Virtual Contours | Options' 

 button. 

  

 

The ‘Contour by Collection Scan’ option can be a useful tool for evaluating calibrated collection scan data and the 

overall accuracy of the project’s sensor alignment. This methodology is typically utilized for a quick analysis of LiDAR data 

and is intended to support QA/QC activities. The following steps outline how to generate contours by collection scan.  

 

1. Data Loading: Load LiDAR dataset (ex. LiDAR, imagery, tiles, control points, etc.) into MARS®.   

2. Data Rendering: Change the default point rendering to ‘Color by Classification’ , which will display all of the 

LiDAR data classifications. Click the ‘View Classification’  button on the ‘View’ tab to launch the 

‘Classifications Display Settings’ dialog, which can be used to toggle specific data classifications on and off. 

Click the ‘Ground (All)’ button to render only the bare-earth points. Zoom in to an area where there is an overlap of 

collection scans. Click the ‘TIN’   button on the ‘View’ tab to switch from a point display to a TIN display to 

view the data more easily. 
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3. Contouring Options: Click the ‘Virtual Contours | Options’ button  on the ‘Analysis’ tab and enter the 

desired contouring options including selecting the ‘Contour by Collection Scan’ check box. To generate ‘on-the-

fly’ contours, click the ‘Area to Display’  button and drag a box over the area of interest. This action 

will cause MARS® to generate a set of contours for each of the included collection scans (see the figure below), 

which provides the user with a method to visually examine the contours in overlap areas. 
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4. Visual Analysis: The user will be able to quickly determine if the data has been properly calibrated and post-

processed by visually inspecting the coincidence of the collection scan contours.     

 

Collection scan contours that are very close in proximity with each other indicate excellent sensor calibration and data 

accuracy. Collection scan contours that diverge or have a large spatial difference indicate poor sensor calibration and 

substandard data accuracy. 

12. Check for Crossing Breaklines (available with Production license only): 

This tool , found on the Breaklines tab, will search for any crossing breaklines in a project. Breaklines loaded as 

'Reference Breaklines' will be included in the crossing check.  The user can choose which types of breaklines will 

participate in the check. The software will only recognize crossings in which the Z value (elevation) of each line is 

different. If the Z value of both breaklines is the same or if the breakline points have been snapped together the crossing 

will be considered an intersection and will not be counted. The resulting 'Breakline Crossing' window will notify the user of 

the total number of breakline crossings and allow the user to pan to each instance by use of the 'Previous' or 'Next' 

buttons. The crossings will be marked with X's - the user can choose the size and color of the X's which will mark the 

crossings. The user may choose from a set of pre-defined colors or create a custom color. The available font size of the 

X's ranges from 1 to 30. The 'Clear' button allows the user to clear the number of recorded crossings and the X's marking 

those crossings from the LAS Map View window. In the 'Breakline Crossing' window seen below, the user has chosen to 

view the 2nd crossing found out of 6 total crossings. 
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13. Scale Bars: 

 This tool (on the ‘View’ tab) will toggle on or off the display of scale bars in the LAS Map View window. This allows 

the user to gauge the horizontal distances within a project on the screen. 

 

Please see the screen capture below as an example. Note that the scale bars are located on the bottom and left sides of 

the MARS® LAS Map View window. 

 

 

There is a similar tool on the ‘Cross-Section/Profile’ tab to toggle an elevation scale on and off in the Cross-Section/Profile 

window.  

 

14. ‘Collection Scan Direction’ Option: 

The ‘Collection Scan Direction’ tool  (on the ‘View’ tab) allows the user to view the direction in which each collection 

scan was acquired. The collection scan direction will be indicated with arrows pointing in the direction of acquisition. The 

lines and arrows are color coded to match the color of the corresponding LiDAR data when rendered using the ‘Color by 

Collection Scan’  button.  
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The example below shows five collection scans color coded in white, pink, yellow, purple, and green. By turning on the 

Collection Scan Direction tool, it is possible to see the corresponding arrows showing the direction of acquisition. 

 

This example shows the same five color coded collection scan direction arrows with the LiDAR data turned off. 

 

 

15. Z Delta/Flight Line Separation – JPEG 2000 

a. Color by Z Delta: 

This tool  will color the points in the LiDAR data by the vertical difference in adjacent flight lines. Clicking the 'Color 

by Z Delta' button on the ‘View’ tab will bring up the options interface.  

 

  

✓ Increment: Specify here how many elevation units should be between principal colors. 

✓ Complete color cycle: This text box will automatically update to tell the user how many complete color 

cycles will be used based on the 'Increment' number entered. 
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✓ Using average TIN: If this check box is used, the Z delta will be determined using the average TIN value of 

all collection scans.  

 

✓ Pick a collection scan as a reference: This drop down box is automatically populated with the collection 

scan numbers of the collection scans shown on the screen at the time the Color by Z Delta button was 

selected. If the user would like to have the Z Delta be determined by the value of a particular collection scan, 

then this option should be used. Make sure the 'Using average TIN' check box is unchecked. 

 

✓ Display cut off value: The user has the option of entering a unit value in this text box which would be 

considered out of the realm of possibility. For instance, in one collection scan a car may have been parked 

beside the road off which LiDAR points were collected. In the next (adjacent) collection scan the car is absent, 

and LiDAR points were collected from the road which was beneath the car. Because the two collection scans 

collected slightly different data, they will vary vertically in this area. The 'Display cut off' text box will tell the 

software to simply ignore data outside this value range. If a value of 4 feet is entered, for example, the vertical 

discrepancy between a car on the side of the road vs. no car in the same location will be ignored. 

 

Example: The data in the screen shot below has been well boresighted. The user has chosen a collection scan as a 

reference against the other collection scans, and the results show that most of the ground points are green. This means 

the Z difference between any given collection scan and the collection scan which acts as a reference is less than the 

allowable tolerance set by the user. The areas of yellow suggest a slightly larger Z difference. The areas of orange 

suggest an even larger Z difference, and the red areas show the largest areas of Z difference. The areas of red and 

orange should be QC’ed carefully to make sure that the areas of larger differences are explainable and a boresighting 

issue is not to blame. 
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b. Flightline Separation – JPEG 2000: 

This export type is intended for use over an entire project database via an exported raster file type (JPEG 2000). Images 

are generated based on the relative height differences between LiDAR data in overlapping areas. The overlap area 

differences are color coded, allowing the user to immediately detect relative vertical accuracy problems. The non-

overlapping areas will show intensity gridded data for reference purposes only. This tool is useful for rapidly assessing the 

consistency of the LiDAR dataset's height and is highly useful in boresighting. Over hard surfaces (such as roads) the 

user can expect the vertical height within the same ‘cell’ to be the same regardless of the LiDAR collection scan from 

which the data originates. Differences are an indicator of a potential mission anomaly (typically a GPS/IMU problem) or a 

post-processing data adjustment issue. In areas such as forests or fields, where vegetation growth varies according to the 

time of year, understandable error may be seen. Lastly, the overlaid collection scan separation coloration will have a 

transparency set to it so that the output raster will still have some feature definition visibility. 

A more accurate (and potentially more useful) variation on this export is the production of a measurable RMSDz raster 

and Z difference value.  This option tests only in areas of overlap/sidelap, and searches out just those Single Return 

points that are a minimum distance from points with other return values.  The ‘Search radius for single return clustering in 

data units’ value is automatically calculated as ten times the Ground Sample Distance (GSD, also referred to as NPS) to 

help ensure that the areas used for the export are in open areas, but not so far that the number of points used is 

insufficient for an accurate result.  In this way, the data that is tested and exported is much more likely to be ground in 

open areas, especially if the ‘Display cutoff value’ (explained below) is small enough to weed out non-system anomalies 

but large enough to ignore differences caused by targets in one collection scan not being present in an adjacent scan (a 

car, for example).  A good starting point is 10 times the ‘Elevation increment’ (also explained below). 

1) Use either the 'Export' button  (Single File export of the entire loaded dataset), or the 'Export Area' button 

 (User-defined Box) to select the area which will be exported to a JPEG 2000 file.  

2) Under the 'Export Type' tab, make sure the 'Type' selected is ‘Flightline Separation - JPEG 2000’, and choose 

an output folder. Checking the 'Use temporary local disk space to speed up processing' box and specifying a 

temporary local folder allows the user to process locally, even if the output folder is on a network drive. Browse to 

any local folder which has space available in it. The export interface will then tell the user how much space is 

required and how much free space is in the folder listed in the browse box. If there is enough disk space, the 

export process will use the local space to speed up processing. If not, another drive/folder must be chosen. 

Additional options in the lower-right corner of the tab allow for handling multi-channel data, and producing a 

measurable separation value (RMSDz) for the collection scan separation (see above). 

3)  Select the classifications, returns, and collection scans for export under the 'Filters' tab. At least one class, return 

type, and collection scan must be selected for export to take place. By default, all classes and collection scans are 

used, but only Last Return points.  If the ‘Measurable RMSDz FSR’ option is used (see above), then Single 

Returns are used instead. 

4) A multi-threading tool may be found in the MARS® export utility. It is available for use with most export types, and it 

functions to speed up export by using a specified amount of a computer’s CPU processing power. The multi-

threading options can be found at the bottom of the export interface in the right hand corner. Initially, the text box 

will show the maximum number of threads available for processing. Leave as is, or enter the desired number of 
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threads to use in processing here. If ‘1’ is entered in the text box, it is equivalent to single-threading the process. 

Ideally, there should be a minimum of three (3) GB of RAM available (not just installed) per thread for best 

performance. 

 

 

5) Under the 'Grid' tab, select the 'Color by Collection Scan Separation' option. Click on the 'Colors Options' 

button to define the elevation increment and color representation options as seen in the screen shot below, then 

click ‘OK.’ When this is complete, choose the 'Export' button to export the data by collection scan separation.  

   

 

✓ Elevation increment: Specify here how many elevation units should be between principal colors. To test 

against the USGS LiDAR specification (<= 10 cm Z difference), for example, a value of ‘0.05’ should be 

entered for projects in meters so that both green and yellow would be in compliance with the spec, but orange 

and red would not.  Projects in feet should use a value of ‘0.16’. 

✓ Use Intensity Threshold: Check this box to set high and low intensity value ranges. Pixels meeting these 

criteria will be rendered in magenta and blue, respectively, and will be displayed on top of pixels rendered by 

collection scan separation. 

✓ Display cutoff value: The user has the option of entering a unit value in this text box which would be 

considered out of the realm of possibility. For instance, in one collection scan a car may have been present 

from which LiDAR returns were collected. In the next collection scan the car is absent, and LiDAR points were 
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collected from the road which was beneath the car. Because the two collection scans collected slightly 

different data, they will vary vertically in this area. The 'Display cutoff value' text box will tell the software to 

ignore data outside this value range. If a value of ‘0.5’ meters is entered, for example, the vertical discrepancy 

between a car versus no car in the same location will be ignored. A good starting point for this value is 10 

times the ‘Elevation increment’. 

✓ Transparency (0-100): The user can set the transparency of the collection scan separation coloration over 

the output raster. The default value is set to 50. As stated in the GUI itself, a value of 0 would show no 

intensity image and only show the collection scan separation coloration. A value of 100 would show the 

intensity image only with no collection scan separation coloration. 

 

Example: The Color by Collection Scan Separation tool has been used to export the raster shown below. The collection 

scan overlap is represented by the colored sections of data. There is an east-west cross scan included in this example. 

The areas with no overlap are rendered by intensity value only.  

 

 

Example: As defined by the user in the 'Collection Scan Separation Colors Options' window, the colors in the example 

below represent varying amounts of error. Green represents areas with the least amount of Z difference between the 

collection scans, whereas red and orange areas show the user areas with larger amounts of Z difference. These 

red/orange areas may point to problems with the GPS, IMU, or post-processing data adjustment. In this example, the 

Color by Collection Scan Separation tool has colored a lake red. In the case of this particular data, the cross scan was 

flown a month after the other collection scans and the red coloration is explained in that the water level of the lake was not 

the same at the time of each scan. On the other hand, the road by the lake should be at the same height in both collection 

scans. The road is green, indicating that the cross scan and this particular collection scan are properly boresighted.  
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The JPEG 2000 files produced by this export type will not automatically be loaded into MARS® when the export is 

complete unless the corresponding box is checked on the ‘Options’ tab of Export. To view the resulting rasters, please 

load them using ‘Add Images’ button on the ‘Project/Data Preparation’ tab.  See the MARS® Help Topics file for more 

information, including a description of the rasters and tables produced.  

 
 

16. Hillshade 

a. Color by: 

A float grid colored by hillshade can be used to quickly and accurately find misclassifications after hand filter. In order to 

view a float grid colored by hillshade, a float grid must first be loaded into MARS®. To see the gridded, elevation float grid 

colored by hillshade, click on the 'Color by Hillshade'   button and hillshade will be calculated and displayed. Because 

hillshade is being calculated and displayed ‘on the fly’, display can sometimes be slow. This tool may also be used to view 

a float grid in 3D (perspective) view. Remember, only float grids can be colored by hillshade.  

 

 

 b. Export to JPEG 2000: 

In MARS®, the user is also capable of exporting an LAS file to a Hillshade JPEG 2000 image. A JPEG 2000 image, or 

*.jp2, is a much more compressed file than a float grid or *.flt file. This allows the display of a *.jp2 to be much quicker and 

the image may act in the same way as an *.ecw file. This option is part of the MARS® export tool. 

• Exporting an LAS to create a hillshade JPEG 2000 image:  

1) Start by loading the LAS data which will be needed to create an image. 

2) When data has been loaded, choose the 'Export'  (after selecting tiles) or 'Export Area'  button. 

3) When the export interface appears, make sure the ‘Export Type’ tab is showing and specify an output directory. 

This will be the folder to which the final JPEG 2000 (*.jp2) file is written after processing is complete.  If desired, 

choose the ‘Save to Local Option’ and specify a temporary processing folder. 

4) Choose the 'Hillshade - JPEG 2000' option in the 'Type' drop down box. 

5) Adjust sun Azimuth and Altitude settings as desired.  The default values are 315 and 45. 

6) Under the 'Layout' tab in the Export interface, specify a file name for the newly created .jp2 file in the 'File' text 

box. 

7) If any other parameters of export need to be set, please make those entries in the remaining tabs located on the 

export interface.  
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8) When all the conditions of the export have been set, click the 'Export' button at the bottom of the interface. The 

progress bar, elapsed time, and estimated time to complete will allow the user to see the export in process. 

9) When the export is complete a pop-up will appear which informs the user that the export was successful.  

To see the newly created JPEG 2000 image click the upper half of the 'Add Images' button on the 'Project/Data 

Preparation' tab. Make sure the 'Files of type: JPEG 2000' is selected at the bottom of the 'Open' interface. Navigate to 

the output folder previously designated and load the *.jp2 file. Once loaded, the image can be found in the table of 

contents under ‘Rasters.’ This resulting image may only be seen in 2D (orthographic) view and CANNOT be viewed in 3D. 

 

17. Ability to Add and View a Float Grid in 2D or 3D: 

To load a float grid into MARS®, click the 'Add Float Grid' button on the 'Project/Data Preparation’ tab. Navigate to the 

float grid (*.flt) to be loaded and select it. Choose 'Open'.  

 

Once a gridded, elevation float grid (*.flt) is loaded into MARS®, the user may pan or zoom around the data in 2D or 3D. 

To view the float grid in 2D, or orthographic view, make sure the 2D  button is selected on the toolbar. To view the 

float grid in 3D, or perspective view, make sure the 3D  button is selected. The example below on the left is a float 

grid of a stadium in 2D view. The example below on the right is a float grid of the same stadium as viewed in 3D.  

     

 

18. ‘Flood Fill’ Tool: 

The ‘Flood Fill’ tool  is located on the ‘Analysis’ tab and will generate a flood fill in a specified region. By applying this 

tool, the user may view areas of LAS data which would fill with water during a flood. The user may specify the lowest 

elevation in which to apply the flood and then use the Elevation slider to simulate different flood severities. The user may 

also choose the color and transparency of the flood fill. It is also possible to save the flood fill to a 3D shapefile. Check this 

option and choose a shapefile name and folder location, then click ‘Save’ to create the shapefile. Click ‘Display’ to show 

the results of the flood. 
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The examples below show the results of different flood severities. The example on the left shows flooding up to an 

elevation of 5264 feet; the example on the right shows flooding up to 5279 feet. 

        

 

 

 

Another example of a flood fill (3D view): 

 

 

 

19. Real-time LAS Shifting 

a. LAS Shifting (X, Y, and/or Z): 

Using a global data shifter to shift all the LAS files in an entire project can sometimes help the project meet specs. This 

sort of shift can be done after hand editing is finished and a control report has been run to determine the average Z 

(elevation) error in a project. To use this shifting tool, click on the 'XYZ Shift' button (available with Production license 

only) on the ‘Coordinate Conversion’ tab or highlight the file in the Table of Contents and click the ‘Shift’ button at the top 

of the table. The shift tool is also used to shift data on the X and Y coordinates. This tool is capable of shifting east (a 

positive value in the Translation East text box), west (a negative value in the Translation East text box), north (a positive 

value in the Translation North text box), or south (a negative value in the Translation North text box). The shift tool is 

capable of shifting the elevation (Z value) of the data by entering a positive value (to move data up higher) or a negative 

value (to move data down lower). In the table of contents, it is possible to select multiple LAS files and apply the 

necessary shifts to all of them. Use the 'Shift' key on the keyboard to select several files in consecutive order, or use the 
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'Ctrl' key on the keyboard to select several files in random order. The selected files will all have the same shifts applied to 

them as specified by the user in the 'MARS LAS Shifter' interface. When shifting LAS data using the Table of Contents 

'Shift' button, a *.off file (one per shifted LAS file) is created which stores the pre-shift X, Y, and Z offset values read from 

the LAS file header.  These files are created in the same folder as the LAS files that were shifted.  The *.off files are used 

as a baseline by the 'Report LAS Shift' tool to create a comma-delimited (*.csv) report that stores the total (cumulative) 

shift for each of the files chosen to be included in the report.  To use the tool, add one or more shifted LAS files using the 

'Add' button, or add an entire folder of shifted LAS files using the 'Add From Folder' button.  Choose a path and file 

name for the output CSV file - click on the ellipse button, then navigate to the desired output folder and enter a filename 

and finish by clicking 'Save.'  To create the report, click the 'Run' button at the bottom of the tool interface. 

 

**NOTE: Multiple shifts are cumulative. 

     
 

 
 

  

 

b. Z Shift For LAS Files (available with Production license only): 

The 'Z Shift For LAS Files' tool, found on the ‘Coordinate Conversion’ tab, allows the user to batch shift the Z value, or 

level the elevation, of all LAS files in a project by use of a *.csv file. This tool is meant for use after boresight has been 
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completed. The corresponding *.csv file must include a header row, the file names of the LAS files to be shifted, and the 

adjustment value to be made to each file. It is important to note that the adjustment values to be made to each file need to 

be in the project units unique to that particular project. A sample *.csv file may be seen inside the 'Z Shift For LAS Files' 

interface. To use this tool, point to the LAS files by clicking on the 'Add' button in the top right hand corner and add the 

LAS files which need flight line shifts. To remove single or multiple files, highlight the file(s) to be removed and click on the 

'Remove' button. Specify the corresponding *.csv file in the 'Spec File (CSV)' section and designate an output folder. If no 

output path is specified, the LAS files will be overwritten. 

 

 

 

c. Z Shift On Intensity (available with Production license only): 

This tool, found on the ‘Coordinate Conversion’ tab, is capable of shifting LAS data that matches a specific user defined 

intensity value. The ‘Z Shift Value’ is also defined by the user. After the LAS data is loaded into the ‘Z Shift On Intensity’ 

tool, the user can make entries in the text boxes provided to specify an ‘Intensity’ value that will be shifted, and the ‘Z Shift 

Value’ to apply to those intensities. An output folder can be designated to create a new dataset (rather than overwriting 

the original files) and progress can be tracked inside the ‘Z Shift On Intensity’ interface. 
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d. Z Shift On Class (available with Production license only): 

This tool, found on the ‘Coordinate Conversion’ tab, is similar to the 'Z Shift On Intensity' tool, but instead is capable of 

shifting the Z value of LAS data by classification. After the LAS data is loaded into the ‘Z Shift On Class’ tool, the user may 

access the text boxes provided to specify a 'Class’ value (or values) that will be shifted, and the ‘Z Shift Value’ to apply to 

those classes. An output folder can be designated to create a new dataset (rather than overwriting the original files) and 

progress can be tracked inside the ‘Z Shift On Class’ interface. 

 

 
 
 
 

 

20. Collection Scan Polygon Generator Tool: 

This option, found on the ‘Vector Creation’ tab, allows the user to generate a polygonal shapefile based on collection 

scans from LAS data acquisition. The user may choose which algorithm the process will use to generate the polygons: 

'TIN' or 'Grid': 
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• 'TIN': If the user selects this option, the edges of the polygonal shapefile(s) will be created based on the edge of 

the virtual TIN which is created. MARS® will use 3 points to create a TIN and the edge of this TIN will denote the 

edge of the polygonal shapefile.  

• 'Grid': If the user selects this option, the edges of the polygonal shapefile(s) will be created based on the edges of 

a virtual grid. When this option is selected the user may further specify a cell size. The default cell size is 3 – in 

other words, the virtual grid is 3 ground units by 3 ground units in size. The cell size should be greater than or 

equal to the ground sample distance (GSD).  MARS® looks for points within the specified virtual cell size grid and 

establishes the edges of the collection scan data by determining whether or not points exist in a cell. When points 

are no longer located, the edge of the collection scan is confirmed. 

The user may also choose either of the following options when creating the polygons:  

• 'Each file corresponding to one collection scan': This option will allow the user to create one shapefile 

containing all collection scan polygon footprints for the chosen LAS files. One shapefile will be output. 

• 'Perform full statistics': If this option is chosen, density and GSD per classification per collection scan will be 

calculated on the classes which are specified in the 'Class Statistics' section. This section will become available 

when the 'Perform full statistics' option is chosen. Make specifications by clicking on the 'Select' button. 

 

The user will then need to browse to the LAS file(s) which will be used to generate the collection scan polygons, or 

browse to an entire folder of LAS files to be used in generating the polygons.  For the 'Output Shapefile,' navigate to the 

folder in which the newly generated shapefile should be stored and give it a name. Click the appropriate 'Generate' button 

(depending on the input method used) and the results will appear in the 'Running Status' text box. A message in this box 

will appear when the process is complete. 

 

The newly created *.shp may then be brought back into MARS®. If the ‘Perform full statistics’ option was checked, the 

user can right-click on the new shapefile in the Table of Contents, choose 'Attributes' and view an attribute table specific 

to that shapefile. The attribute fields included in the statistics will be: the file name, collection scan numbers, all points 

count, area, density, average GSD, the minimum intensity, the maximum intensity, the mean intensity, median intensity, 

and mode of the intensity values. Also included will be the: minimum and maximum GPS time values, the point count for 

each class included in the collection scan polygon generation, and other fields as described in LAS Statistics (above). 
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Below is the resultant reference shapefile loaded into MARS®. The shapefile outlines each of the collection scans 

contained in the LAS files chosen by the user. This can be a useful tool in checking the overlap between collection scans 

and making sure there are no gaps in the data. 

 
 

 

21. Batch Script Test Function to Step (Forward or Back) Through Macros: 

 

The purpose of these tools (on the ‘Edit/Filter’ tab) is to allow the user to run through macros step by step (manually) 

rather than running a script as a whole (batch processing tiles). Steps can be run one-at-a-time and the user can easily 

distinguish the breaks between filters. This allows the user to stop processing at any point to see the effects an individual 

filter may have on the data as well as to edit the filter options. Manual/GUI (graphical user interface) methods are slower 
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than automated processes, so this method should only be used for testing. ‘Batch Process Tiles’ is run in RAM, and can 

run behind the scenes much more quickly for higher performance. 

 

: This button allows the user to start a step-by-step run through each filter of the selected macro (ex. 

@: Canopy) for a specified test area (determined by dragging a box). 

 

: This tool allows the user to step to the next filter of a macro. Pressing this button once will only run through 

the next single filter in the macro. 

 

 : This tool rolls back the actions of the previous filter in the macro. 

 

: Proceed through all steps of the macro to the end. 

 

: Stop the filtering process. This tool is used after the ‘Go’ button has been clicked to stop the process of 

the filter at the current step without canceling the action entirely. 

 

: Restart filtering process from the beginning of the macro. 

 

: Will bring up the edit dialog window to modify any filters in the loaded macro. 

 

 

On the Status Bar, the user will find a short summary of the filters found in the loaded macro. The first number tells the 

user the filter number (step) that has just been run (ex: 6/18: the software is currently processing or has just completed 

the sixth filter in a macro which has a total of 18 filters). The name of that filter will be shown next to these numbers. This 

is to give the user an overall idea of where the macro is in processing and to let the user know which filter is running if it 

should need to be edited or removed from the macro. 

 
 

22. ‘Convert SBET to Shapefile’ Tool and ‘Scan Angle’ Filter Tool: 

The final step in a typical work flow is to produce an SBET, or Smoothed Best Estimated Trajectory file. This means 

computing the tightly integrated position and orientation solution using the correction observations, the raw GPS and 

inertial data extracted from the work flow. The data is processed in both the forward and backward directions in order to 

produce the optimal solution, smoothing the effect of GPS outages and other aberrations in the data. This results in the 

best possible position and orientation solution for a given dataset, usually maintaining centimetric accuracy for 

significantly more time and at longer distances than would be possible with traditional GPS processing. The output from 

this process is referred to as an SBET. The 'Convert SBET to Shapefile' tool will create a 3D shapefile from an SBET file, 

giving the user the ability to visualize the SBET overlaid on LiDAR data. This tool does require some previous knowledge 

of geodesy. Among many other purposes, the 'Convert SBET to Shapefile' tool can be used to see how centered in the 

scan the SBET is, and the resultant shapefile can be used in the ‘Scan Angle’ filter. 
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Once the conversion is finished the user may now load the newly created 3D shapefile into MARS®. This is done by going 

to the 'Project/Data Preparation' tab and clicking the 'Add Reference Shapefiles' button. Navigate to the output folder 

which was specified in the 'Convert SBET to Shapefile' interface and select the *.shp file which matches the name of the 

SBET used to create it. In the example below, the 3D shapefile created from the SBET is loaded along with the 

corresponding LiDAR data.  
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To enter ‘Scan Angle’ filter settings and use this tool, choose ‘Scan Angle’ from the 'Filter Action' drop-down list on the 

‘Edit/Filter’ tab. Click the 'Filtering Options'  button, which will bring up the appropriate interface to 

enter in the desired settings. The Scan Angle filter is made specifically for use with the 'Convert SBET to Shapefile' tool. 

The Scan Angle filter uses an SBET file which has been converted into a 3D shapefile to reclassify certain sets of points. 

Remember that the 3D shapefile used in this filter represents the SBET, and this is the actual path of the plane in flight. 

The LiDAR data, which represents the ground beneath the plane, is collected at different angles in relation to the plane. 

See the diagram below for further explanation: 

 

 

In this filter, the points are reclassified based on the scan angle (actually, the scan angle rank). In the diagram above, the 

points collected on the ground at the bottom of the blue arrow represent a different scan angle than those points collected 

at the bottom of either of the red arrows. This filter reclasses points based solely on their scan angle rank. The user may 

enter several different parameters based on minimum and maximum scan angle ranks, resulting in several different 

classes of points, each representing a separate scan angle rank range (see example below). This filter can be used to run 

statistics of density per class or to run statistics based on the density of the scan angles.  

 

 

 
 

23. ‘Single Collection Scan to Multiple’ Tool (available with Production license only): 

This tool (under the ‘Collection Scans’ drop-down on the ‘Tools’ tab) will split a single collection scan into multiple, smaller 

collection scans in areas indicated by the flight heading, or angle, which is user defined. Having multiple, smaller 

collection scans versus a single, large collection scan may help in boresighting and in measuring elevation differentiations 

between collection scan overlaps.  
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1. To use this tool, first load the LAS data which coincides with the large collection scan (that is to be separated into 

multiple smaller collection scans) by choosing the 'Add' button.  

2. To remove added LAS files, simply select the file to be removed and choose the 'Remove' button. 

3. Next point to the SBET shapefile which is associated with the LAS file(s) loaded.  

4. Specify the sampling rate at which to produce the new collection scans by entering an integer into the 'Use every 

__ points in the shapefile' text box. This feature of the 'Single Collection Scan to Multiple' tool allows the user to 

reduce the sampling rate of (or thin out) the heading data from the SBET file by allowing the user to define a time 

range. 

 

The examples shown below depict a 1 second sampling rate (left) and a 30 second sampling rate (right). 

   

 

5. Define an output folder for the new multiple collection scans. 

6. Choose a starting collection scan number for the naming convention of the new multiple collection scans to be 

created. 

7. Choose an angle at which collection scans will be separated. Whenever the angle specified here is found in the 

single collection scan, the process will split the collection scan in two. 

8. When all settings have been entered, click the 'Run' button. 
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9. When the process is complete the user will be notified with a prompt as seen here: 

 

 

In the example below on the left, the LAS data is shown colored by collection scan. There is only a single, long collection 

scan loaded. The SBET shapefile is shown as the pink point shapefile. In the example on the right, the collection scan 

shown previously has been converted to multiple collection scans (each discrete color) with the collection scan angle 

specified for separation at 90 degrees. 

           


